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INTRODUCTION
Mastercam’s DynamicMotion toolpaths deliver powerful benefits that help you get the most fromany machine.

These 2D and 3D high-speed dynamicmilling toolpaths utilize the entire flute length of their cutting tools to achieve
greater efficiency inmilling. They are designed to maximize material removal while minimizing tool wear.

Additional benefits you gain by using high-speed dynamicmilling toolpaths include:

l Tool burial avoidance

l Minimumheat buildup

l Better chip evacuation

l Extended tool life

This tutorial introduces you to Mastercam's intelligent, application-specific, 2D and 3D high-speed dynamicmilling
toolpaths.

Tutorial Goals

l Learn the benefits and uses of the dynamic toolpath types

l Create basic dynamic toolpaths

l Create stockmodels

l Learn to use other Mastercam toolpath utilities

NOTE
Youmust have a 3D license to complete the Dynamic OptiRough chapter.

Screen colors in the tutorial pictures were modified to enhance image quality; they may not match your Mastercam
settings or the tutorial results. These color differences do not affect the lesson or your results.

Estimated time to complete this tutorial: 5 hours
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General Tutorial Requirements
All Mastercam 2021 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operation system.

l The tutorials cannot be used withMastercamDemo/Home Learning Edition. The Demo/HLE file format (emcam)
is different fromMastercam (mcam), and basicMastercam functions, such as file conversions and posting, are
unavailable.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you
complete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be access from the Mastercam 2021workstation, either with the
tutorial or in any location that you prefer.

l Youwill need an internet connection to view videos that are referenced in the tutorials. All videos can be found
on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.

The Chaining Dialog Box
Starting withMastercam 2020, the Chaining dialog box displays as one of two versions: theWireframe Chaining
dialog box or the Solid Chaining dialog box. When this tutorial refers to these dialog boxes in general, it will use the
term "chaining dialog box," with no uppercase or bolding.
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DYNAMIC TOOLPATHS OVERVIEW
The following toolpaths use DynamicMotion technology:

l Dynamic Contour

l Face

l DynamicMill

l PeelMill

l Dynamic OptiRough

Each toolpath has benefits that make it unique.

Dynamic Toolpath Types

Dynamic Contour
The Dynamic Contour toolpath creates a familiar contour operation using dynamicmotion and specialized options
found only in dynamic toolpaths. The dynamicmotion prevents tool burial and binding in small radii corners.
Additionally, you can specify howMastercammachinesmaterial left on the walls.

Face
The Face toolpath, when the Style is set toDynamic, quickly cleans stock from the top of a part and creates an even
surface for future operations. You can base the toolpath on either chained geometry or on the current stock setup.
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Dynamic Mill
The DynamicMill toolpathmachines pockets, leftover material, standing bosses, or cores. By setting theMachining
region strategy to Stay inside or From outside, you can create a pocket toolpath that uses dynamicmotion or a
facing operation that has island avoidance capabilities.

By selecting the Stay inside strategy, DynamicMill becomes a pocket toolpath that uses dynamicmotion. You select a
boundary, areas to avoid, and set tooling, parameters, entry method, and linking values to generate the toolpath.
Material is removed inside-to-outside in a highly efficient manner.

By selecting the From outside strategy, DynamicMill becomes a facing operation that has island avoidance
capabilities. Thismovement creates a toolpath that is allowed tomove outside the selectedmaterial and removes
material outside-to-inside.
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By enabling Rest Material on the Stock page, the DynamicMill toolpath uses dynamicmotion to remove material left
by previous operations. The DynamicMill operation calculates howmuchmaterial to remove based on previous
operations or previous roughing tools. Only unmachined areas are processed for a DynamicMill operation.

Peel Mill
PeelMill, with the Cutting strategy set toDynamic Peel, allows for efficient milling between selected chains. It uses
a dynamic style of motion with accelerated back feedmoveswhen the tool is not engaged inmaterial. For a single
chain, you define the width of the cut. Otherwise, the width is defined by the area between two contours.

Dynamic OptiRough
The Dynamic OptiRough toolpath is currently the only 3D toolpath that usesMastercam’s DynamicMotion technology.
It supports cutters capable of machining very large depths of cut. A single Dynamic OptiRough toolpath can cut
material in two directions: on stepdowns (-Z) and stepups (+Z). This bi-directional cutting strategy removes the
maximumamount of material with the minimumamount of stepdowns, significantly reducing cycle times.

Similar to DynamicMill, you can select From outside or Stay inside whenmachining. However, instead of selecting
regions, you select machining geometry, avoidance geometry, and containment boundaries.

Mastercam Dynamic Milling Tutorial—2: Dynamic Toolpaths Overview



Dynamic Toolpath Selection
The Dynamic toolpaths, especially the DynamicMill toolpath, require a unique way of understanding chain selection.
Dynamic Contour does not require a closed chain to calculate a toolpath. All geometry selected is cut by the tool
motion. PeelMill requires at least one open chain and no closed chains.

DynamicMill allows you to have evenmore control over your chaining by allowing you to select multiple kinds of
regions with one toolpath. The types of regions are listed below:

l Machining regions: Areas to be machined.

l Avoidance regions: Areas to be avoided duringmachining. Multiple avoidance regions can be selected.

l Air regions: Areas that contain nomaterial and allow the tool to travel through it whenmachining.

10
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l Containment regions: Areas that limit toolmotion.

l Entry chain: The point where the tool enters the part or a custom chain for the entry motion to follow.

If the machining regions are open chains, you can extend the open chain to stock with the Open chain extension to
stock options. You can also close the open chains with open Air regions, connecting the start and end of the open
Machining regions. If no open chains are selected, and noOpen chain extension to stock options are selected,
they are automatically closed with a straight line.

For more information, viewMastercam’sHelp.

As the only 3D Dynamic toolpath, Dynamic OptiRough uses a different selectionmethod than the other Dynamic
toolpaths. When creating aDynamic OptiRough toolpath, you are brought to theModel Geometry page in the
Surface High Speed Toolpaths - Dynamic OptiRough dialog box. You then have the following options:

l Machining Geometry: Geometry to be machined. You can have multiple machining groups.

l Avoidance Geometry: Geometry to be avoided. You can have multiple avoidance groups.

l For each geometry group, you can assign variable stock-to-leave values on its walls and floors.

You can then use the Toolpath Control page to set containment parameters, which control the tool's position around
the boundary of your part.

Mastercam Dynamic Milling Tutorial—2: Dynamic Toolpaths Overview



Dynamic Milling Parameters
Several parameter options separate the Dynamic operations from their standard counterparts. These parameters are
on the Cut Parameters, Entry Motion, and Contour Wall pages.

l Micro lifts

l Entry methods

l Entry feeds/speeds

l Contour wall

l Approach distance

Micro lift options allow the tool to rise above the floor of the part for the portion of the toolpath that is not removing
material. Benefits of the micro lift include chip clearing and avoiding excess tool heat. The feed rate is controllable for
the backmove aswell.

Entry methods provide several ways to enter the material for a DynamicMill toolpath. Options range froma simple
helix to amedial path with trochoidalmotion to a selected open chain. Mastercam’s Help contains detailed information
on eachmethod.

Use Entry feeds and speeds to avoid placing excessive load on the tool upon entry. Set a short dwell interval after
entry to allow the spindle to reach the necessary speed before beginningmaterial removal.

12
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Contour wall parameters provide input for remaining stock and previous tool information. The values entered help
Mastercam to calculate the most efficient material removal strategy whenmachining part walls.

The Approach distance parameter allows you to add a specified incremental distance to the beginning of the
toolpath’s first cut.

Dynamic toolpaths, which are part of the group of 2D and 3D High Speed Toolpaths (HST), create highly efficient
motion based on selected chains and surfaces. The dynamic toolpaths are similar to standard Pocket, Contour, and
Area Roughing toolpaths, but with the stated enhancements.

Creating and reviewing the motion of dynamic toolpaths, which you do in the rest of this tutorial, is the best way to
learn about the benefits and uses.
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CHAPTER 1

THE DYNAMIC MILL TOOLPATH
The DynamicMill toolpathmachines pockets, open pocket shapes and standing cores, or material left fromprevious
operations.

In this chapter, you create two DynamicMill toolpaths. The first one clearsmaterial around the outside of the part. The
second DynamicMill toolpath uses the previous one as a source operation for removing the remainingmaterial on the
top of the part.

Goals

l Set up stock

l Create two DynamicMill toolpaths

l Preview region chains

l Verify the created toolpaths

Exercise 1: Opening Mastercam
1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System Configuration dialog
box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-down list.
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d. ClickOK.

Exercise 2: Setting up the stock
In this exercise, you set up stock that is used for the first toolpath.

1. Open the part file, DynamicMill, provided with this tutorial.

2. Save the part as DynamicMill-xxx, replacing xxx with your initials.

3. On theMachine tab, selectMill,Default.

4. Select the LevelsManager, located in the same area as the ToolpathsManager. If it is not displayed, select
Levels on the View tab to toggle the display, or press [Alt+Z].

Before creating the stock shape, you first create a level on which to place the stock geometry. This is a good
practice for organizing part files that have thousands of lines, arcs, solids, or surfaces.

5. On the LevelsManager, select Add a new level.

Mastercamadds a new level to the list, and sets it as the main level.

16
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6. Double-click in the Name column of the level you have just created and rename it to Stock geometry.

You nowuse this level for the geometry created by the stock setup.

7. Select Stock setup in the ToolpathsManager.

TheMachine Group Properties dialog box displays.

8. On the Stock setup tab, click Bounding box.

The Bounding Box function panel displays.
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9. Select the entire part, as shown below:

10. Press [Enter] or click End Selection to accept the selection.

11. Set the following parameters in the Bounding Box function panel:

l Shape to Rectangular. This shape is better suited for this part than Cylindrical.

l Z to 28.6. Sets the size of the box in the Z axis.

l Under Create Geometry, select Lines and arcs. This will create, based on the stock shape, lines and
arcs that can be used for many functions.

12. ClickOK to accept and create the boundary and return to theMachine Group Properties dialog box.

18
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13. ClickOK in theMachine Group Properties dialog box. The part nowdisplays with the stock boundary and
geometry.

You have now created the necessary stock and geometry to create the DynamicMill toolpaths.

14. Click in the graphics window to ensure that all selected geometry is deselected.

15. Save your part.
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Exercise 3: Creating the first Dynamic Mill toolpath
You now create the first DynamicMill toolpath to machine the outside of the part.

1. Select Dynamic Mill from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

2. Click Select underMachining regions. Machining regions are the regions that are going to be machined.

3. If the Solid Chaining dialog box displays, click theWireframe button.

4. Select Cplane in theWireframe Chaining dialog box.

This option allows you to chain only entities that are parallel to the current construction plane and at the same Z
depth as the first entity you chain.

20
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5. Select the chain shown below as the machining region:

By changing the chaining selection to Cplane, you avoid selecting each line individually.

6. ClickOK in the chaining dialog box to return to the Chain Options dialog box. 

7. Set theMachining region strategy to From outside.

From outside uses free-flowingmotion to machine features such as standing bosses or cores. To clear the
outside of the part, this is the strategy you want.

8. Click Select under Avoidance regions. Avoidance regions are regions that you want to avoid duringmachining.
In this case, you want to avoid the part itself and clear out the area between the stock boundary and the part.
To do this, you will need to activate another level.

The chaining dialog box displays.
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9. Select 3D in the chaining dialog box.

Thismode chains entities defined in the X, Y, and Z axes simultaneously.

10. Select the LevelsManager. Move the chaining dialog box out of the way if necessary.

11. Click in the Visible column for the Part geometry level.

The graphics windownowdisplays the geometry you need to select. A silhouette of the part, this geometry
allows you to machine around the part and clear out the stock, but without cutting into the part.

12. Select the chain shown below as an avoidance region:

13. ClickOK in theWireframe Chaining dialog box to accept the chain and return to the Chain Options dialog
box.
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Before you accept these chains in the Chain Options dialog box, you first preview them to ensure that these
are the chains you want.

14. Right-click in the graphics window, and set the view to Top (WCS).

15. In the Chain Options dialog box, click Preview chains.

Your part displays as shown in the following image:

Mastercamdisplays the material in the red and black crosshatch, the motion region as blue, and the tool
containment as yellow. By using Preview chains, you can determine if the results are correct before entering
parameters.

You can change these colors by selecting the Color button. These options are also available on the Toolpath
Type page.

16. Once you are satisfied, right-click in the graphics window and select Isometric (WCS).

17. ClickOK in the Chain Options dialog box to accept these chains.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.
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18. Select the Tool page.

19. Click Select library tool.

The Tool Selection dialog box displays.

20. Select Filter.

The Tool List Filter dialog box displays.

24
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21. SelectNone to remove all filters, and then select EndMill3 Bull. This ensures that you showonly Bull endmill
tools.

You can also double-click a tool image to set the filter.

22. ClickOK in the Tool List Filter dialog box.

23. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/R1.0 tool. If necessary, expand the
Tool Name column to view the entire tool name.

24. ClickOK in the Tool Selection dialog box to add the tool to the toolpath.

You can also double-click the tool to add it to the toolpath.
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25. Select the Cut Parameters page.

26. Set the following parameters:

l Approach distance to 9.5. Adds a specified distance to the beginning of the toolpath’s first cut.

l Stepover to 50.0. Sets the distance between cutting passes in the X and Y axes.

l Minimum toolpath radius to 2.5. Mastercamuses this radius in combination with theMicro lift
distance and Back feed rate parameters to calculate 3D arcmoves between cutting passes.

l Micro lift distance to 0.0. Sets the distance the tool lifts off the part on backmoves.

l Back feedrate to 0.0. Controls the speed of the back feedmovement of the tool.

l Cut order optimization toNone. Directs the toolpath to start at the most recently machinedmaterial
when cutting.

l Stock to leave on walls to 0.5. Leaves a defined amount of stock on the vertical drive geometry.

l Stock to leave on floors to 0.0. Leaves a defined amount of stock on horizontal drive geometry.

27. Select the Entry Motion page.

26
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28. Set the following parameters:

l Helix radius to 0.0. Sets the radius of the entry helix.

l Z clearance to 0.0. Sets an extra height used in the rampingmotion down froma top profile.

l Plunge angle to 0.0. Sets the angle of descent for the entry move and determines the pitch.

This toolpath does not enter down into the stock, so you do not need to set entry parameters.

29. Select the Linking Parameters page.

30. Set the following parameters:
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l Deselect Retract. The retract distance is the height that the toolmoves up to before the next tool pass.

l Set Top of stock to 1.0.

l Change Top of stock andDepth to Absolute. Mastercammeasures absolute values from the origin
0,0,0.

31. Select Depth to return to the graphics window.

Depth determines the finalmachining depth and the lowest depth that the tool descends into the stock. In this
case, the machining depth is in the middle of the part because DynamicMill uses the entire tool to cut.

32. Select the chain shown below:

Mastercam returns to the 2D High Speed Toolpath - Dynamic Mill dialog box. Your Depth should nowbe set
at -20.32.
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33. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box to generate your toolpath. The toolpath
displays as shown below:

34. Save your part.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



Exercise 4: Creating the second Dynamic Mill toolpath
You now create a second DynamicMill toolpath, using the Rest material option.

1. In the ToolpathsManager with the DynamicMill toolpath selected, select Toggle display on selected
operations.

This option hides the display of the first toolpath and keeps your graphics view uncluttered while you create
another toolpath.

2. Select Dynamic Mill from the 2D gallery on theMill, Toolpaths contextual tab.

The Chain Options dialog box displays.

3. Click Select underMachining regions.

The chaining dialog box displays.

30
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4. Select the bottom stock geometry as the machining region. Use the Cplane button to select the entire chain.

The selection is the same geometry used in the first DynamicMill toolpath.

5. ClickOK in theWireframe Chaining dialog box to return to the Chain Options dialog box.

6. Ensure that theMachining region strategy is set to From outside.

7. Click Select under Avoidance regions.

The chaining dialog box displays.
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8. Select the chain shown below as an avoidance region. Set the chaining to 3D.

Youmay need to rotate the part or turn off the Solid level to select the chain.

9. ClickOK in theWireframe Chaining dialog box to accept the chain and return to the Chain Options dialog
box.

10. ClickOK in the Chain Options dialog box to accept these chains.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.

11. Select the Tool page.

12. In the tool list, select the tool that was used for the previous DynamicMill toolpath, which is END MILL WITH
RADIUS - 20/R1.0.
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13. Select the Stock page.

14. Select Rest material.

This enables the page and tells Mastercam to calculate the cutting passes based on the remaining stock.

15. Set the following parameters:

l Set Compute remaining stock from toOne other operation. This calculates the remaining stock
froma single operation.

l In the Operation List, select the 2D High Speed (2D Dynamic Mill) toolpath.

l Set Adjustments to remaining stock toUse as computed. This optionmakes no adjustments to the
stockmodel.

Mastercam Dynamic Milling Tutorial—1: The Dynamic Mill Toolpath



16. Select the Cut Parameters page.

17. The parameters are the same as the previous operation’s, so ensure that your toolpathmatches the
parameters shown below:

18. Select the Entry Motion page.

34
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19. The parameters are also the same as the previous operation’s, so ensure that your toolpathmatches the
parameters shown below:

20. Select the Linking Parameters page.

21. Set the following parameters:

l Feed plane to 2.5. Sets the height that the tool rapids to before changing to the plunge rate to enter
the part.

l Ensure that Feed plane is set to Incremental.

l Top of Stock to 0.0. Sets the top of the stock.

l Ensure that Top of stock andDepth are set to Absolute.
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22. ClickDepth to return to the graphics window.

23. Select the arc shown below (you will need to rotate the part):

24. Mastercam returns to the 2D High Speed Toolpath - Dynamic Mill dialog box. Your Depth should be -10.16.

25. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box to generate your toolpath.

26. The toolpath will display as shown below:

Notice that the toolpath clears out the top of the part while avoiding the large feature that was selected as the
avoidance region.

27. Save your part.

Exercise 5: Verifying the toolpaths
Youwill now verify both DynamicMill toolpaths withMastercam Simulator. Mastercam Simulator allows you to verify
your toolpaths by using solidmodels to simulate part machining against a selected stock definition. Verify creates a
representation of the surface finish and shows collisions, if any exist. Use Verify to identify and correct programerrors
before they reach the shop floor.
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1. Select Toolpath Group-1 in the ToolpathsManager.

Both DynamicMill toolpaths are selected.

2. Select Verify selected operations.

Mastercam Simulator displays.

3. Right-click in the graphics view and select Fit and Isometric from the menu. Mastercam Simulator shouldmatch
the image shown below.
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4. View the Move Info, which displays all pertinent information about the toolpaths being verified. With the given
parameters, DynamicMill toolpaths canmachine the part in the time shown. (Your time may be different from
what is shown here.)

5. Press Play to preview the toolpathmotion for both operations.

6. Once you are satisfied with your results, close Mastercam Simulator.

7. Save your part file.

The DynamicMill toolpaths quickly remove the stock on the outside and prepare the part for other necessary
operations. In the next lesson, you create a Face toolpath to further machine this part.

38
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CHAPTER 2

THE FACE TOOLPATH
Face toolpaths clean the stock from the top of a part and create an even surface for future operations. This toolpath
can be based on chained geometry or on the current stockmodel.

For this chapter, you create a Face toolpath on the top of the part from the DynamicMill lesson.

Goals

l Create a Face toolpath

l Preview the toolpath before it has been created

l Verify the created toolpath

Exercise 1: Creating the Face toolpath
1. Open the part file, FaceMill, provided with this tutorial.

2. Save the part as FaceMill-xxx, replacing xxx with your initials.

3. Select Face from the 2D gallery on theMill Toolpaths contextual tab.

The chaining dialog box displays.

4. If necessary, select Solids to activate solid selection.
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5. Activate Face selection. This allows you to select the face of a solid.

6. Select the face shown below:

7. Select OK in the Solid Chaining dialog box.

The 2D Toolpaths - Facing dialog box displays.

8. Select the Tool page.

40
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9. Select the END MILL WITH RADIUS - 20 / R 1.0 that was used in the previous two DynamicMill toolpaths. If
necessary, expand the Tool Name column to see the entire tool name.

10. Select the Cut Parameters page.

11. Set the following parameters:

l Style toDynamic. Creates a smooth controlledmotion that cuts from the outside to the inside,
maintaining a constant load on the tool withminimal entries and exits.
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l Stock to leave on floors to 0.0. Sets the amount of stock to leave on the floors duringmachining.

l Maximum stepover to 50.0. Sets the distance between adjacent passes in the toolpath.

12. Select the Linking Parameters page.

13. Set the following parameters:

l Deselect Retract. Sets the height that the toolmoves up to before the next tool pass.

l Set Feed plane to 2.5. Sets the height that the tool rapids to before changing to the plunge rate to
enter the part.

l Set Top of stock to 0.2. Sets the height of the material in the Z axis.

Before clickingOK, you first preview the toolpath. Previewing toolpaths allows you to view the toolpath before
generating it so that you canmake adjustments as necessary.

42
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14. Select Preview toolpath on the 2D Toolpaths - Facing dialog box.

The toolpath will display on the part as shown below:

15. ClickOK in the 2D Toolpaths - Facing dialog box to close and generate the toolpath.

16. Save your part.
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Exercise 2: Verifying the toolpaths
You now verify the two DynamicMill toolpaths created from the previous chapter and the Face toolpath together.

1. Select Toolpath Group-1 in the ToolpathsManager.

This selects both DynamicMill toolpaths and the Facing toolpath.

2. Select Verify selected operations.

Mastercam Simulator displays.

3. Right-click in the graphics view and select Fit and Isometric from the menu. Mastercam Simulator shouldmatch
the image shown below.
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4. Press Play to preview the toolpathmotion for the toolpaths.

There will be material remaining on the top face of the part. That is to be expected.

5. View theMove Info, which displays information about the toolpaths being verified. With the given parameters,
the three toolpaths canmachine the part in the time shown.

6. On the Verify tab, click the Color Loop button to activate the function. Then select Color Loop,By Operation
to help distinguish between each toolpath.

Mastercam Simulator color-codes each toolpath so that you can distinguish where they cut the part. The colors
on the part correspond to those on the time bar. The second image following shows the results.
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7. Once you are satisfied with your results, close Mastercam Simulator.

8. Save your part file.

Using the DynamicMill toolpaths and the Face toolpath, you have quickly cleared the part to prepare it for finishing
operations. In the next lesson, you create two Dynamic Contour toolpaths.

46
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CHAPTER 3

THE DYNAMIC CONTOUR TOOLPATH
Mastercam’s Dynamic Contour toolpathmillsmaterial off walls and supports closed or open chains. Compared to its
standard counterpart, the Dynamic Contour toolpath providesmore efficient cutting by using the entire flute of the
tool.

In this chapter, you create aDynamic Contour toolpath to clear around the walls of the part.

Goals

l Create two Dynamic Contour toolpaths

l Analyze the toolpaths

l Verify the created toolpaths

Exercise 1: Setting up the stock
1. Open the part file, DynamicContour, provided with this tutorial.

2. Save the part as DynamicContour-xxx, replacing xxx with your initials.

3. On theMachine tab, selectMill,Default.

4. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.
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5. Select Bounding box on the Stock Setup tab.

The Bounding Box function panel displays.

6. Select the part and press [Enter] or select End Selection.

7. Set Z to 13.7. This adds a small amount of stock to the Z height of the stock boundary.

8. ClickOK to have Mastercam create the boundary.

9. ClickOK to accept the stock setup.
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Exercise 2: Creating the first Dynamic Contour toolpath
1. Select Dynamic Contour from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.

2. Click Select under Machining regions.

The chaining dialog box displays.

3. If theWireframe Chaining dialog box displayed, select Solids to activate solid chainingmode.

From this point on, this tutorial assumes that you know to switch fromone version of the chaining dialog box to
the other, as needed.

In solid chainingmode, the Solid Chaining dialog box gives you options to manage the chaining of solid entities.
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4. Select Loop if it is not already selected. Deselect Face if it is selected.

This allows you to select a closed chain on a reference face.

5. Select the edge shown below. Youmay need to zoom in.
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6. If necessary, click Reverse so that the chain looks like the following image.

7. ClickOK in the Solid Chaining dialog box to accept the chains and return to the Chain Options dialog box.

8. ClickOK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

9. Select the Tool page.

10. Click Select library tool.

The Tool Selection dialog box displays.

11. Click Filter.

The Tool List Filter dialog box displays.

12. Set the Tool Type filter toNone.
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13. Select the Endmill1 Flat filter. This ensures that you are only selecting flat endmill tools.

14. ClickOK in the Tool List Filter dialog box.

15. In the Tool Selection dialog box, select the FLAT END MILL - 4 tool.

16. ClickOK in the Tool Selection dialog box.

17. Select the Cut Parameters page.

52

Mastercam Dynamic Milling Tutorial—3: The Dynamic Contour Toolpath



53

18. Set the following parameters:

l Compensation direction to Left. Offsets the tool to the right or left of the toolpath.

l Approach distance to 5.0. Adds a specified incremental distance to the beginning of the toolpath’s first
cut.

l First pass offset to 1.0. Offsets the machining region to ensure the tool does not engage toomuch
material during the first pass of the toolpath when entering stock from the outside.

l Stepover to 15.0. Sets the distance between cutting passes in the X and Y axes.

l Minimum toolpath radius to 5.0. Sets the minimum toolpath radius for the operation.

l Set Stock to leave on walls and Stock to leave on floors to 0.0. You are not leaving stock on the
vertical and horizontal surfaces.

19. Select the Contour Wall page.

20. Set the following parameters:
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l Radius of tool that shaped the stock to 8.0.

l Minimum toolpath radius that shaped the stock to 1.0.

l Stock thickness to 0.025.

The parameters help define the shape of the stock removed by the toolpath. Mastercam calculates the stock to
remove along the contour wall by using these parameters.

21. Select the Linking Parameters page.

22. Set the following parameters:

l Retract, Top of stock, andDepth to Absolute. Measures absolute values from the origin 0,0,0.

l Retract to 15.0. Sets the height that the toolmoves up before the next tool pass.

l Feed plane to 3.0. Sets the height that the tool rapids to before changing to the plunge rate to enter
the part.

l Top of stock to 13.7. Sets the height of the material in the Z axis.

23. Select Depth. You return to the graphics window.

Depth determines the finalmachining depth and the lowest depth that the tool descends into stock. You will
select an edge for this toolpath.
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24. Select the edge shown in the following image:

You automatically return to the Linking Parameters page. Your Depth should nowbe 9.525.

25. ClickOK in the 2D High Speed Toolpath - Dynamic Contour dialog box to accept and generate your toolpath.
Your toolpath displays as shown below:

26. Save your part.

Exercise 3: Creating the second Dynamic Contour toolpath
1. Select Dynamic Contour from the 2D gallery on theMill Toolpaths contextual tab.

The Chain Options dialog box displays.
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2. Click Select underMachining regions.

The chaining dialog box displays.

3. Set the chaining to Edges. Also ensure that 3D is selected.

This allows you to select contiguous chaining of edges.

4. Zoom in using the mouse wheel, and select the edge shown below.
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5. The chain will display as shown below. Reverse the direction if needed, using Reverse on the chaining dialog
box.

6. Use the Next control in the Solid Chaining dialog box to extend the chain, as shown below.

7. In the Solid Chaining dialog box, click End chain.

This ends the chain so that you can start a newone that is not linked to the previous chain.
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8. Using the controls in the Solid Chaining dialog box, select the second partial chain shown below:

9. ClickOK in the Solid Chaining dialog box to return to the Chain Options dialog box.

10. ClickOK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

11. Select the Tool page.

12. Click Select library tool.

The Tool Selection dialog box displays.

13. Select the FLAT END MILL - 8 tool.

14. ClickOK in the Tool Selection dialog box.

15. Select the Cut Parameters page.
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16. Set the following parameters:

l Approach distance to 12.0.

l First pass offset to 3.0.

17. Select the Contour Wall page.

18. Set Radius of tool that shaped the stock to 12.0.

19. Select the Linking Parameters page.
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20. Set the following parameters:

l Retract to 16.0 and Absolute.

l Feed plane to 3.0 and Incremental. Incremental values are relative to other parameters or chained
geometry.

l Top of stock to 9.525 and Absolute.

l Depth to 0.0 and Incremental.
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21. ClickOK to generate the toolpath.

The toolpath will display as shown below:

Exercise 4: Analyzing the toolpaths
You now analyze the toolpath. Analyze Toolpath allows you to view toolpath properties, such as coordinates,
direction, operation number, and other information by hovering over the toolpath.

1. Select Analyze Toolpath from the Home tab.
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2. Hover over the first toolpath:

Analyze Toolpath reports the operation number, the feedmove, spindle speed, G1 and the line length, and the
coolant code. It also displays the start and end of the toolpath and of the section you are hovering over, and
sometimes position information. If there ismore than one toolpath displayed at the time, then toolpaths other
than the one you are hovering over are dimmed.

3. Continue hovering over areas of both toolpaths. Once you are satisfied, press [Esc] or Cancel out of the
function.

Exercise 5: Verifying the toolpaths
Youwill now verify both toolpaths.

1. Select Toolpath Group-1 in the ToolpathsManager.

This selects both toolpaths so that they can be verified at the same time.
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2. Select Verify selected operations.

Mastercam Simulator displays.

3. Right-click in the graphics view and select Fit and Isometric, if necessary, so that the display matches the image
below:
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4. View theMove Info, which displays all pertinent information about the toolpaths being verified. By using two
Dynamic Contour toolpaths, the totalmachining time is approximately one minute. (You time result may vary.)

5. Press Play to preview the toolpathmotion for both operations. The second image following shows the results.

6. Once you are satisfied with your results, close Mastercam Simulator.

7. Save your part file.

In the next chapter, you create three PeelMill toolpaths.
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CHAPTER 4

THE PEEL MILL TOOLPATH
The PeelMill toolpath, with the Cutting strategy set toDynamic peel, allows for efficient milling between selected
chains. It uses a dynamic style of motion with accelerated back feedmoveswhen the tool is not engaged inmaterial.

In this chapter, you create one PeelMill toolpath, copy it twice, andmake edits.

Goals

l Create a PeelMill toolpath

l Copy and paste the toolpath

l Make edits to the copied toolpaths

l Verify the created toolpaths

Exercise 1: Setting up the stock
1. Open the part file, PeelMill, provided with this tutorial.

2. Save the part as PeelMill-xxx, replacing xxx with your initials.

3. On theMachine tab, selectMill,Default.

4. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.
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5. Select Bounding box.

The Bounding Box function panel displays.

6. Select the part, and press [Enter] or click End Selection.

This part needs no additional geometry. The bounding box will be accepted as it is.

7. ClickOK to create the boundary.

8. ClickOK to accept the stock setup.
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Exercise 2: Creating the first Peel Mill toolpath
1. Select Peel Mill from the 2D gallery on theMill Toolpaths contextual tab.

The chaining dialog box displays.

2. Select Edges if it has not already been selected. Deselect Face if it is selected.

This allows you to select the solid edges of amodel.

3. Select Translucency on the View tab. You can also turn on translucency with the Translucency button in the
status bar or by pressing [Ctrl+T].

This toggles the translucency of the current model and will help with selection for this first toolpath.
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4. Select the two edges shown below. Use Reverse if necessary to ensure both chains go in the same direction.

5. Toggle Translucency off.

6. ClickOK in the Solid Chaining dialog box.

The 2D High Speed Toolpath - Peel Mill dialog box displays.

7. Select the Tool page.

8. Click Select library tool.

The Tool Selection dialog box displays.
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9. Click Filter.

The Tool List Filter dialog box displays.

10. Verify that tools are filtered to Endmill1 Flat.

11. ClickOK in the Tool List Filter dialog box to accept the filter and return to the Tool Selection dialog box.

12. Select the FLAT END MILL - 12 tool.

13. ClickOK to add that tool and exit the Tool Selection dialog box.

14. Select the Cut Parameters page.

Mastercam Dynamic Milling Tutorial—4: The Peel Mill Toolpath



15. Set the following parameters:

l Stepover to 20.0%.

l Minimum toolpath radius to 5.0%.

l Select Extend Exit and set Additional exit distance to 3.0. This adjusts the final tool engagement with
the material.

16. Select the Linking Parameters page.

17. Set the following parameters:

l Set Retract to 40.0.

l Set Feed plane to 40.0.
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18. Click Top of stock to return to the graphics window to select the top of the stock of the part.

19. Select the point shown below:

You automatically return to the Linking Parameters page. Top of stockwill be set at 38.1.

20. ClickOK in the 2D High Speed Toolpaths - Peel Mill dialog box to generate the toolpath.

The toolpath will display as shown below:

21. Save your file.
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Exercise 3: Copying the Peel Mill toolpath
In this exercise, you copy the PeelMill operation twice in the ToolpathsManager.

1. Right-click on the 2D High Speed (2D Dynamic Peel Mill) toolpath, and drag and drop it below the red insert
arrow.

2. Select Copy after from the right-click menu that displays.

Mastercam copies the toolpath below the original. There are now two PeelMill toolpaths in the Toolpaths
Manager.

3. Click and drag the red arrow to position it below the copied operation.

4. Copy the toolpath once more. You will nowhave three PeelMill toolpaths in the ToolpathsManager.

Copying and pasting toolpaths is helpful when you have to do similar cuts on the same part. In the case of these
toolpaths, you will have to re-chain the geometry.

a. Click and drag the red arrowbelow the third toolpath.

5. Save your file.
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Exercise 4: Re-chaining the copied Peel Mill operations
In this exercise, you will re-chain the geometry for the PeelMill toolpaths that were copied.

1. Select Geometry under the second PeelMill toolpath.

The Chain Manager dialog box displays.

2. Right-click in the Chain Manager dialog box, and select Rechain all.

The chaining dialog box displays.

3. Select the chains shown below. Ensure that the chains are both going in the same direction. Youmay need to
rotate the part or select Translucency on the View tab to select them.

4. ClickOK in the Solid Chaining dialog box to return to the Chain Manager dialog box.
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5. ClickOK in the Chain Manager dialog box.

Before regenerating the toolpath, you will re-chain the third operation.

6. Select Geometry under the third PeelMill toolpath.

The Chain Manager dialog box displays.

7. Right-click in the Chain Manager dialog box and select Rechain all.

The Solid Chaining dialog box displays.

8. Select the chains shown below. Ensure that the chains are both going in the same direction.

9. ClickOK in the chaining dialog box to return to the Chain Manager dialog box.

10. ClickOK in the Chain Manager dialog box.

11. Select Regenerate all dirty operations in the ToolpathsManager.

The second and third PeelMill toolpaths regenerate using the newly selected chains. All three PeelMill
toolpaths will display as shown below:
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12. Save your file.

Exercise 5: Verifying the toolpaths
In this exercise, you will verify all three PeelMill operations together.

1. Select Toolpath Group-1 in the ToolpathsManager to select all of the toolpaths.

2. Select Verify selected operations.

Mastercam Simulator displays.
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3. Right-click in the graphics view and select Fit and Isometric, if necessary, so that the display matches the image
below:

4. View theMove Info to view the total run time of the toolpaths.

5. Press Play to preview the toolpathmotion for the operations.

6. Once you are satisfied with your results, close Mastercam Simulator.

7. Save your part file.

When creating similar toolpaths, copying and pasting saves time. In the next chapter, you create two Dynamic
OptiRough operations and a stockmodel operation.
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CHAPTER 5

THE DYNAMIC OPTIROUGH TOOLPATH
The 3D surface high-speed Dynamic OptiRough toolpath uses an aggressive, fast, intelligent roughing algorithmbased
onMastercam’s 2D high-speed dynamicmillingmotion.

In this chapter, you create two Dynamic OptiRough toolpaths using different cutting strategies and a stockmodel
operation in order to rough out the part.

Youmust have a 3D license to complete this Dynamic OptiRough lesson.

Goals

l Set up the stock

l Create two Dynamic OptiRough toolpaths

l Create a stockmodel operation

Exercise 1: Setting up the stock
In this exercise, you create the stockmodel that will be used for the first Dynamic OptiRough toolpath.

1. Open the part file, DynamicOptiRough, provided with this tutorial.

2. Save the part as DynamicOptiRough-xxx, replacing xxx with your initials.

3. On theMachine tab, selectMill,Default.

4. Select the LevelsManager, located in the same area as the ToolpathsManager. If it is not available, select
Levels from the View tab to toggle the display.

Before creating the stock shape, you will first create a level on which to place the stock geometry. This is a good
practice for when you need to organize part files that have thousands of lines, arcs, solids, or surfaces.
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5. On the LevelsManager, select Add a new level.

A new level is added to the list and is then set as the main level.

6. Double-click in the Name column of the level you have just created and rename it to Stock geometry.

This level will nowbe used to place the geometry created by the stock setup.

7. Select Stock setup from the ToolpathsManager.

TheMachine Group Properties dialog box displays.

8. Select Bounding box.

The Bounding Box function panel displays.
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9. Window select all entities to create a bounding box around the entire part.

10. Press [Enter] to accept your selection.

11. Set the following parameters in the Bounding Box function panel:
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l Set Shape to Cylindrical.

l Set Radius to 150.

l Set Height to 102.00. This will add a small amount of stock at the top of the part.

l Set Axis to Z.

l Center on axis should be on.

l Lines and arcs should be on.

12. ClickOK to create the boundary.

13. ClickOK in theMachine Group Properties dialog box to accept the stock setup.

The stock displays as a dashed outline in red. The geometry that was created with the bounding box also
displays.
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Exercise 2: Creating the first Dynamic OptiRough toolpath
In this exercise, you create the first Dynamic OptiRough toolpath that uses this stock boundary.

1. Select OptiRough from the 3D gallery on theMill Toolpaths contextual tab.

TheModel Geometry page of the Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.

2. Select theMachining group, and then click Select entities under Machining Geometry.
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3. Use window select or any applicable keyboard shortcuts to select the part body as the machining geometry. This
includes the blue caps, as shown below.

4. Press [Enter] or click End Selection to accept these surfaces.

You return to theModel Geometry page.

5. Because you are creating a roughing toolpath, enter the following stock-to-leave amounts on the wall and floor.
Double-click to activate the field.

l Enter 0.3 inWall Stock

l Enter 0.3 in Floor Stock

6. Select the Toolpath Control page.
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7. Click the Boundary chains selection arrow.

This button returns you to the graphics window to select one or more closed chains of curves to limit the tool
motion.

8. Ensure that the chaining dialog box is set toWireframe and, in the graphics window, select the circular
geometry at the top of the stock boundary.

9. ClickOK to return to the Toolpath Control page of the Surface High Speed Toolpaths - Dynamic
OptiRough dialog box.
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10. Set the containment boundary Strategy to From outside and, in the Skip pockets section, set Smaller than to
66.0.

From outside sets the toolpath to machine fromoutside the containment boundary moving in. This strategy is
best used for machining cores.

Skip pockets specifies aminimumpocket size that Mastercamwill create a cutting pass for. This helps with
problemswhere Mastercam thinks that a pocket is large enough to accommodate the tool, but the entry move
is so compressed that the tool is effectively plunging into the part.

11. Select the Tool page.

12. Click the Select library tool button.

The Tool Selection dialog box displays.

13. Select Filter.

The Tool List Filter dialog box displays.

14. Set the Tool Type filter toNone.

15. Select the Endmill3 Bull filter. This ensures that you are only selecting bull endmill tools.

16. ClickOK in the Tool List Filter dialog box.

You return to the Tool Selection dialog box.
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17. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/R2.0 tool.

18. ClickOK in the Tool Selection dialog box to add the tool to the toolpath.

19. Select the Cut Parameters page.

20. Set the following parameters:

l Optimize stepups to By pocket. Mastercam first machines all stepdowns,moving frompocket to
pocket. After all stepdowns on a Z-level are machined to completion, Mastercammachines the stepups
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by next closest, in the safest cut order.

l Stepover to 30.0%. Sets the distance between cutting passes in the X and Y axes.

l Stepdown to 150.0%. Determines the Z spacing between adjacent cutting passes.

l Select the Stepup checkbox and enter 15.0. Mastercam calculates and adds stepup cutting passes (+Z)
to the toolpath.

l Minimum toolpath radius to 10.0. Sets the minimum toolpath radius to create in the operation.

l Micro lift distance to 0.0.

l Back feedrate to 100.0. Controls the speed of the backfeedmovement of the tool.

l % of tool diameter to 10000.0.

21. Select the Transitions page.

22. Set Helix radius to 9.0.

23. Select the Linking Parameters page.
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24. Set the following parameters:

l Set the Retract Method drop-down toMinimum Distance. Creates high-speed loops into and out of
each retract move.

l Select Output feed move and enter 12500.0. Outputs the rapidmove between passes as a feed rate
move instead of a rapidmove. This helps when the tool needs to make many irregular moves per pass
to jump between different areas of the part.

25. ClickOK to close the Surface High Speed Toolpaths - Dynamic OptiRough dialog box and generate your
toolpath. (It may take a fewmoments.)

26. Your toolpath should display as follows:

27. Save your part file.
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Exercise 3: Creating the Stock Model operation
You now create a Stock Model operation that uses the previous operation as its source. This stockmodel will be used in
the second Dynamic OptiRough toolpath to remove any remaining stock.

1. On the ToolpathsManager, select Only display selected toolpaths.

Mastercamwill nowonly display the toolpath you have selected. It will also clean up the graphics viewwhen
makingmodifications to the part or creating another toolpath.

2. Select Stock Model on theMill Toolpaths contextual tab.

The Stock model dialog box displays.

3. Name the stock operationOP1 Stock.

Naming your stockmodel based onwhich operation it is using is helpful, especially when you have a part with
multiple stockmodel operations.

4. Set Color to 128.

This color will help differentiate the stockmodel from the solid or surface model.

5. Select Stock Setup.

Stock Setup copies the values defined in theMachine Group Properties dialog box to corresponding fields in
the Stock Definition page. The values are not associative.
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6. Select the Source Operations page.

7. Select the Surface High Speed (Dynamic OptiRough) toolpath as the source operation.

Mastercamwill generate the stockmodel by running the selected operation against the parameters on the
Stock Definition page.

8. ClickOK to create the stockmodel operation. Thismay take some time to calculate.

Your stockmodel displays as shown below:

9. Turn off Only display selected toolpaths from the ToolpathsManager.

10. Save your part.
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Exercise 4: Creating the second Dynamic OptiRough toolpath
You now create aDynamic OptiRough toolpath that uses the stockmodel you created in the previous exercise.

1. Select Toolpath Group-1 in the ToolpathsManager.

2. Select Toggle display on selected operations twice. Mastercamhides all selected toolpaths to keep the
graphics window clean.

3. Select OptiRough from the 3D gallery on theMill Toolpaths contextual tab.

TheModel Geometry page of the Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.

4. Select theMachining group, and then click Select entities under Machining Geometry.
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5. In the LevelsManager, turn off the display of the Caps level and turn on the Stock geometry level to make it
easier to select the drive surfaces.

6. Select all but the blue caps as the drive surfaces shown below.

7. Press [Enter] or click End Selection to accept these surfaces.

The Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.

8. Select the Toolpath Control page.
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9. Click the selection arrow for Boundary chains to return to the graphics window.

10. In the graphics window, select the circular geometry at the top of the stock boundary.

11. ClickOK in theWireframe Chaining dialog box to return to the Toolpath Control page.

12. Set the following parameters to control the tool’s position around the boundary of your part.

l Set Compensate to toOutside. This sets the outer edge of the tool to be bound to the containment
boundary.

l Set Offset distance to 10.0. This option adjusts the inside or outside tool containment boundary.
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13. Select the Tool page.

14. Click Select library tool.

15. In the Tool Selection dialog box, select the END MILL WITH RADIUS - 10/R1.0 tool.

16. ClickOK to add the tool to the toolpath.

17. Select the Stock page.

18. Select Rest material.

When you enable this page, Mastercam calculates the cutting passes based on the remaining stock.
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19. Set the following parameters:

l Set Compute remaining stock from toOne other operation.

l In the Operation List, select Stock Model - WCS: Top.

l Set Adjustments to remaining stock to Ignore small cusps.

l Set Distance to 1.0. This option is used in conjunction with Ignore small cusps. Mastercamwill output
cuts that engage large amounts of material.

20. Select the Cut Parameters page.
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21. Set the following parameters:

l Optimize stepups toNext closest. Mastercammoves to the closest cut from its last position on the
previous cut.

l Stepover to 30.0%.

l Stepdown to 150.0%.

l Stepup to 30.0%.

l Minimum toolpath radius to 10.0%.

l Motion > Gap size, retract toWhen avoiding a boundary. Adds retracts to avoid intersecting
boundaries (a gouge boundary, or a boundary of material yet to be milled).

22. Select the Transitions page.
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23. Set the Helix radius to 5.5.

24. ClickOK to generate the Dynamic OptiRough toolpath.

25. Select Toggle display on selected operations to display toolpaths again, and select the second Dynamic
OptiRough toolpath to view the newly created toolpath.

26. Save your part file.

Exercise 5: Verifying the stock model and toolpaths
In this exercise, you use Mastercam Simulator to verify your toolpaths and stockmodel. Verifying your toolpaths
allows you to use solidmodels to simulate part machining against the selected stock definition.

1. Select Toolpath Group-1 in the ToolpathsManager.

2. Select Verify selected operations in the ToolpathsManager.

Mastercam Simulator displays.
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3. If necessary, right-click in the graphics window and change the view to Isometric and Fit the part to the screen
so that it matches the image shown below.

4. Click the Play button or press [R] to verify the toolpaths.

Your result should look like the following image:
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5. View the Move Info to view the total run time of the toolpaths.

6. Once you are satisfied with the verification, close Mastercam Simulator.

7. Save your part.
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CONCLUSION
Congratulations! You have completed the Mastercam Dynamic Milling Tutorial! Now that you have mastered the skills
in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will addmore as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software in
the Documentation folder of your Mastercam 2021 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by
pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is open
Monday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to see
the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact your
AuthorizedMastercamReseller, visit university.mastercam.com/, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com.

l Follow us on Facebook (www.facebook.com/Mastercam), Twitter (twitter.com/Mastercam), and
Instagram (www.instagram.com/mastercamcadcam/) for the latest tech tips andMastercamnews.

l See Mastercam in action on YouTube (www.youtube.com/user/MastercamCadCam).

l For more information on CNC Software, Inc., to find and apply to jobs, and connect with people using
Mastercam, visit us on LinkedIn (www.linkedin.com/company/cnc-software/).

l Registered users can search for information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the MastercamKnowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.
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ATTENTION! UPDATES MAY BE AVAILABLE.
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